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Introduction 

This document provides information for candidates about the University’s requirements for 
formatting the final submission for Doctoral and MPhil research degree awards in 
preparation for final assessment. It also provides guidance about creating an accessible 
thesis using Word. Candidates are strongly encouraged to format their work to ensure that 
the widest range of users can access it wherever possible. 

PhD, MPhil, Professional Doctorate awards 

(See the relevant section below for DPhil/MPhil by publication awards). 

The language of the submitted thesis will be English unless an application for an alternative 
has been approved by the Examining Board, body, or designated committee. 

Length of the thesis submission 

The procedures about the length of the thesis are set out in full in the Final Submission 
section of the Doctoral Handbook. They are included here for ease of reference. 

i. The following list the maximum word limits for MPhil, PhD by thesis and Professional 
Doctorate awards: 

Science, engineering, and creative practice/performing arts disciplines: 

• PhD 40,000 words 
• Professional Doctorate 35,000 words, or as detailed in the programme specification 
• MPhil 20,000 words. 
 

For business and management, humanities and the arts, social sciences, health and social 
care and education disciplines: 

• PhD 80,000 
• Professional Doctorate 60,000, or as detailed in the programme specification 
• MPhil 40,000. 

 
Words that should be counted are defined as any and all words included in the text of the 
assessment (counted electronically). The word count will include all text, including (but not 
limited to): the main body of text (including headings), all citations (both in and out of 
brackets), text boxes, tables and graphs, figures and diagrams, quotes, lists. 

References and ancillary data, such as appendices, are not included in the maximum word 
limits. 

ii. An MPhil or PhD thesis incorporating research outputs within the body of the work to 
be assessed may be expected to be longer than a thesis submission that does not 
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incorporate them and may exceed the maximum permitted for that discipline by up to 
10,0000 words. 

iii. Please note that examiners are not obliged to examine additional material included in 
the thesis beyond these word limits. 

iv. There may be award specific requirements for final thesis submission for Professional 
Doctorate awards, and candidates should consult current Programme specifications 
and/or published Programme handbooks for details. 

v. ‘Creative practice’ included in the written part of the final submission for PhD/MPhil 
awards with an approved creative practice focus is not included in the maximum word 
count for the thesis itself, (Regulations at E4.iii) refer). 

Formatting 

The submission must be typewritten, legible and formatted observing the following 
requirements: 

• A4 portrait format must be used. The margins should be set at 40mm/4cm for the left 
edge and a minimum of 15mm/1.5cm for the other edges (see also good practice 
guidance on accessible formatting). 

• The size of the letters in the main text shall not be smaller than 2.0mm for capitals and 
1.5mm for x-height (that is the height of a lower-case x). Depending on the font chosen, 
this may be a minimum of 10pt or 12pt text. 

• Line spacing of double (2.0) or one-and-a-half (1.5) is required for the main body of the 
text except for indented quotations or footnotes where single (1) line spacing is 
acceptable. 

• Pages must be numbered in order and in the margin throughout the main text, including 
photographs and/or diagrams included as whole pages. 

• Standard British English conventions should be used throughout, for example, spelling, 
numbering, and symbols. 

• The examined draft of the thesis must include a word count of the thesis, i.e., excluding 
references and ancillary data such as appendices. Note, this is not required in the final 
publishable version of the thesis. 

Explanatory notes 

The specified margin requirements ensure that the Doctoral Academy can arrange for a 
spiral bound, printed copy of your thesis should this be required by examiners. In such 
cases the thesis will be printed on both recto and the verso (i.e., double sided). 

You should avoid using non - Serif fonts, such as Times New Roman. The more ornate 
the font, the fewer the number of individuals who will be able to read it. Using 
Calibri font or similar makes your document easier to read by a wide range of users, 
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including those with visual, auditory, motor, or cognitive impairments. For more 
guidance about accessible formatting see the guidance below. 

In selecting a suitable font size, it may be helpful to print a single page of text to 
establish the actual size of the x-height. 

What must be included 

The submission for final assessment must comprise as a minimum: 

1. A title page 
2. An abstract 
3. Contents page 
4. Introductory and contextual material 
5. The body of work (your research) 
6. A synthesis of the work that includes the candidate’s claim to meet the qualification 

descriptor (for all Doctoral submissions this includes a claim for original contribution 
to knowledge), and establishes their ownership of the work submitted 

7. Copies of publications as a result of the research not otherwise included for assessment 
at 5. 

Items 4, 5 and 6 shown here in bold form the part of the submission that is assessed. 

Title page 

The title page must include the following information, in order: 

1. The full title of the thesis 
2. The full name of the author 
3. The following text “A thesis submitted in partial fulfilment of the requirements of the 

University of the West of England, Bristol for the degree of (add the degree here, for 
example, Doctor of Philosophy, Master of Philosophy not the abbreviation. For 
Professional Doctorates add the full title of the award ie., for the degree of Professional 
Doctorate in… )” 

4. Where there is a collaborating organisation, their details must be included as follows: 
“This research programme was carried out in collaboration with the (name of the 
collaborating organisation)” 

5. The UWE Bristol College where the candidate was based and any affiliated academic 
institution 

6. The month and year of submission for the final assessment (this will need to be updated 
for each occasion the thesis is submitted). 

 
 Addi�onal guidance: A sample �tlepage (PDF) is available. 

https://www.uwe.ac.uk/-/media/uwe/documents/research/specimen-thesis-title-page
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Thesis title 

The title of the thesis must be the same as the one specified in the EX1 form – Examination 
arrangements (DOC). Once the examination arrangements have been approved and the 
examiners have been appointed this cannot be changed unless specifically requested by the 
examiners during final assessment. 

Abstract 

An abstract of approximately 300 words must be included in the thesis after the title page to 
provide a synopsis of the thesis stating the nature and scope of the work undertaken and of 
the contribution made to the knowledge of the subject. The abstract will be in English. 
Candidates may include a second version of the abstract translated into a language other 
than English if they wish. This should follow the first abstract in terms of the order of 
presentation of material within the submission.  

Acknowledgements 

It is normal practice to include thanks or mention other individuals here, but not mandatory. 

Contents page 

Ideally presented as a ‘Table of Contents’ allowing navigation through the document (see 
guidance on accessibility, layout and Wordstyles below) for example: 

• Introductory Chapter(s) and contextual information,  
• Subsequent Chapter headings and any subsections (for example, your research, what 

you did and how you did it. Can incorporate research outputs for PhD/MPhil)  
• Your conclusions (synthesis of the work submitted, key project findings, your claim for 

original contribution to knowledge, possible future work) 
• Relevant appendices 
• Copies of publications as result of your research, not otherwise included in the body of 

work to be assessed. 

 Addi�onal guidance: Look at published theses on the UWE Bristol Research Repository 
for examples of how to lay things out clearly – there are nearly 1,000 examples available; 
find some that relate to your field of study to see how other PGR candidates have gone 
about it. 

Introductory and contextual material 

May include but is not limited to: 

• Thesis outline or overview; a brief indication of what is described, investigated, 
discussed, or otherwise provided in each chapter.  

https://www.uwe.ac.uk/-/media/uwe/documents/research/gs-ex1-exam-arrangements-2021.doc
https://www.uwe.ac.uk/-/media/uwe/documents/research/gs-ex1-exam-arrangements-2021.doc
https://uwe-repository.worktribe.com/outputs?page=1&Type=Thesis
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• A declaration establishing your ownership of the work. 
• Setting the scene and parameters of your research investigation in the context of your 

field including the main issues, areas of current research, or limitations of the current 
knowledge. May incorporate your literature review if not otherwise a discrete/separate 
chapter. 

• Your aims in addressing these and enhancing current understanding through your 
research. 

• Information about any collaboration with other bodies, organisations or stakeholders 
including, but not limited to, what they provided, for example, resources and funding, 
access to data, knowledge, and other collaborative working etc. 

Body of work  

• Literature review if not incorporated in your introductory and contextual material.  
• The main chapters about your research – what you did and how you did it, for example, 

materials, methods, methodologies, data, critical analysis, findings, interim conclusions 
etc., can be presented as research outputs if you are including them in the body of work 
– see below for more details. 

• Bear in mind that what is included and how it is presented will vary according to practice 
within your field and this guidance is not designed to be a prescriptive list. 

Conclusions 

• A synthesis of the work submitted. Discussion of your key findings for the research as a 
whole.  You may have detailed conclusions for individual elements of your work in the 
previous chapters, but this is where you pull everything together discuss the relevance 
and application of your work as a whole to your field of research.   

• Your claim to meeting the qualification descriptor criteria for your award, and your claim 
for an original contribution to knowledge.  

• Limitations, recommendations and further or future work etc.  

Appendices and ancillary data 

May include lists of figures, tables, equations, abbreviations etc. 

Other publications 

PDFs of publications arising from the research that you are not otherwise incorporating in 
the body of work to be assessed.  Note, Professional Doctorate awards may have 
programme specific requirements about the inclusion and formatting of publications; 
consult the published Programme specification, published Programme handbook and 
discuss with your Director of Studies if in doubt. 
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References 

Ensure that you follow referencing requirements for your discipline.  Discuss with your 
Director of Studies if in doubt. 

 Addi�onal guidance: Where there are no specific disciplinary referencing 
requirements use UWE Bristol Harvard. 

Formatting research outputs into the body of work 
(PhD/MPhil thesis) 

• For MPhil and PhD by written thesis, the body of work of work to be assessed may 
incorporate research outputs produced during the candidate’s registration on the award 
Regulations at E4.iii) and related procedures in the Final Submission section of the 
Doctoral Handbook list what these outputs may include.   

• This option is not currently available for candidates registered on Professional Doctorate 
awards, or for MPhil/PhD candidates following programmes with an approved creative 
practice focus for whom different requirements are in set out in the procedures for Final 
Submission - see the Doctoral Academy Handbook. MPhil/DPhil by publication awards 
are also have different submission arrangements (see below). 

• The outputs to be included do not need to have been published at the point the thesis is 
submitted for final assessment, but they must have been generated during, not prior to, 
the candidate’s registration on the award and should be in suitably publishable state or 
otherwise ready for release into the public domain. 

• Written research outputs incorporated in the body of work should be in a format 
consistent with the rest of the submission wherever possible.  Other kinds of research 
outputs informing the written thesis should be represented by a written and/or visual 
record of the output, or details of how they can be freely accessed.   

• Each written research output and each record of other research output must be 
accompanied by a cover page immediately before it that includes a statement of the 
origin of the work and a declaration of the nature and extent of the candidate’s 
individual contribution to the work, and if it was published details of where it was 
published.  

• Where published outputs are included bear in mind any Intellectual Property/copyright 
issues rela�ng to the journal etc. in which the work appeared. You own the raw text that 
makes up the content of the publica�on, but you do not own any journal specific ‘house 
style’ in terms of forma�ng and font. If you intend to use the exact format as it was 
published, you will need to check with the relevant publisher for permission to do this. If 
you decide to just use the raw text you should indicate this on the cover page for that 
output, and indicate any minor altera�ons to the text. This avoids confusion and ensures 
that everyone, including any publishing house, is clear. 

https://www.uwe.ac.uk/study/study-support/study-skills/referencing/uwe-bristol-harvard
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• Remember that your relevant word limit is increased by a maximum of 10,000 words if 
you are including research outputs; you should avoid going over this addi�onal 
allowance. 

 Additional guidance: about incorporating research outputs into the PhD/MPhil thesis 
(PDF). This additional guidance includes a short video originally produced for research 
degree examiners. 

 

DPhil, MPhil awards by publication 

The language of the critical commentary will be English unless an application for an 
alternative has been approved by the Examining Board, body, or designated committee. 

Length of submission 

The procedures about the length of the submission are set out in full in the Final Submission 
section of the Doctoral Handbook. They are included here for ease of reference. 

i. Research awards by publication (including MPhil and DPhil degrees by publication) are 
assessed by evidence of scholarship through a collection of published work and a critical 
commentary setting out the nature and significance of the collection in terms of its 
contribution to new knowledge within the subject field, together with a viva voce 
examination. 

ii. The critical commentary and collection of published work together form the submission 
for assessment. 

iii. The maximum word limit for the critical commentary for MPhil/DPhil by publication is 
20,000 words. The expected length may vary depending on the field of research and 
many commentaries will be significantly shorter than this maximum. There is no 
minimum word count. Ancillary data, such as appendices and references, are not 
included in the maximum word limit. 

iv. Please note that examiners are not obliged to examine material beyond the maximum 
word limit. 

v. The collection of published work may include books, original and exhibited creative work 
in any medium, peer reviewed publications in the public domain, published patents or 
designs, or other forms of published scholarly output embodying original research. It 
may include work published prior to the candidate’s registration on the award. 

vi. There is no specified minimum or maximum number of published outputs that may be 
submitted as part of the collection, nor is there a specified minimum level of individual 
contribution to each output. This is to ensure that the scholarly and publishing practice 
of differing discipline areas can be reflected appropriately. 

vii. The published collection, when combined with the critical commentary and any 
professional training or development undertaken, must be sufficient to demonstrate 

https://www.uwe.ac.uk/-/media/uwe/documents/research/incorporating-research-outputs-in-your-thesis.pdf
https://www.uwe.ac.uk/-/media/uwe/documents/research/incorporating-research-outputs-in-your-thesis.pdf
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that the candidate meets the requirements of the Doctoral or MPhil qualification 
descriptor at regulation E3 in the Doctoral Academy Handbook. 

viii. The critical commentary should clearly demonstrate the nature and extent of the 
candidate’s individual contribution to each of the works presented and how each 
reflects their own original contribution to current knowledge in the field. 

Formatting 

The submission must be typewritten, legible and formatted observing the following 
requirements: 

• A4 portrait format must be used. The margins should be set at 40mm/4cm for the left 
edge and a minimum of 15mm/1.5cm for the other edges (See also good practice for 
accessible formatting below). 

• The size of the letters in the main text shall not be smaller than 2.0mm for capitals and 
1.5mm for x-height (that is the height of a lower-case x). Depending on the font chosen, 
this may be a minimum of 10pt or 12pt text. 

• Line spacing of double (2.0) or one-and-a-half (1.5) is required for the main body of the 
text except for indented quotations or footnotes where single (1) line spacing is 
acceptable. 

• Pages must be numbered in order and in the margin throughout the main text, including 
photographs and/or diagrams included as whole pages. 

• Standard British English conventions should be used throughout, for example, spelling, 
numbering, and symbols. 

• The examined draft of the commentary must include a word count of the commentary, 
i.e., excluding references and ancillary data such as appendices. Note, this is not 
required in the final publishable version of the commentary. 

What must be included 

The submission must comprise: 

a. A bibliography listing the works being submitted in support of the award. 
b. The proposed title of the submission together with the following statement: 
c. “Published work and a critical commentary submitted in partial fulfilment of the 

requirements of the University of the West of England, Bristol for the degree of Master of 
Philosophy by publication (MPhil) or Doctor of Philosophy by publication (DPhil)”. 

d. A critical commentary setting out the PGR’s view of the nature and importance of the 
work being submitted, the claim of originality, reference to the research methodologies 
used and the applicant’s assessment of the contribution of the published outputs to 
existing knowledge in the relevant subject area. 

e. Where the submission includes jointly/multiple authored works or other types of 
collaboration the PGR will include a statement identifying the separate and distinctive 

https://www.uwe.ac.uk/research/postgraduate-research-study/current-postgraduate-researchers/doctoral-academy-handbook/research-degree-awards#regulation-e3
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nature of their individual contribution to the overall project, both achieved so far and 
planned for the future. 

f. A statement confirming which, if any, parts of the submission has been or is being 
submitted for another academic award. 

g. A statement of the training completed and confirming that the minimum number of 
credited learning requirement has been met. 

h. Where it is not possible to submit elements of the material above electronically or 
provide accessible links to the material, three printed copies of these elements must be 
submitted to the Doctoral Academy. 

Parts b to f of the submission will be in English.  Parts a and g will normally be in English 
unless the subject matter involves substantial language and related studies and approval to 
include another language had been gained at the project confirmation stage from the 
designated Committee. 

Additional guidance for DPhil/MPhil candidates about the 
published collection of work 

• It is expected that the candidate’s contribution to the papers or other published outputs 
submitted will demonstrate that they have played a significant role in developing and 
directing the research.   

• The onus is on the candidate to select those outputs which they feel are representative 
of their original contribution to current knowledge in their field, whether that be as an 
established researcher or as an early career researcher and show via the commentary 
how these outputs demonstrate that they meet the doctoral qualification criteria. 

• It is unlikely that a single publication, for example, a book (unless it is the accepted 
seminal work in the field), or a small collection of multiple authored journal papers will 
be sufficient to evidence the creation of new knowledge through original research 
required by the doctoral descriptor. Likewise, a collection made up solely of patents or 
designs without the inclusion of any peer reviewed journal publications may not be 
sufficient evidence of scholarly research activity. In general candidates should avoid 
overloading examiners with non-essential, or multiple outputs that demonstrate the 
same or very similar things.  

• Where outputs submitted were published some time ago the critical commentary 
should show how they are still relevant to current thinking/knowledge and research 
within the discipline. 

• Previous DPhil/MPhil by publication submissions are available on the UWE Bristol 
Research Repository and candidates are advised to look at these to see how others have 
successfully gone about it. It is possible to filter the search to distinguish DPhil/MPhil 
submissions from PhD theses.  

https://uwe-repository.worktribe.com/outputs?page=1&Type=Thesis
https://uwe-repository.worktribe.com/outputs?page=1&Type=Thesis
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Creating an accessible thesis in Word 

Digital accessibility is a useful skill in any workplace, and it is important to maximise your 
audience by making your documents easy to navigate and understand by a wide range of 
users, including those with visual, auditory, motor or cognitive impairments.  

An accessible document means that it should be easy for anyone to read or reformat and 
can be accessed by people using assistive technology (such as screen readers). Formatting 
your thesis with these accessible features built in will help to ensure that it can be accessed 
and read by the widest audience possible.  

It is not always possible to make all your Word documents accessible to all users. However, 
this guidance aims to show that by making simple changes, it is possible improve the flow of 
your thesis and make it easier for the reader to access the information they need.  

Please see: 

• Creating accessible documents on the staff intranet.  
• Blackboard training course 

When formatting your thesis also please remember to read and follow the University’s 
general requirements about preparing your thesis for submission which are detailed earlier 
in this guidance, and online in the UWE Bristol Doctoral Academy Handbook. 

Structuring your document 

There are a few simple steps to make very long documents like a thesis easier to navigate: 

• Use page numbers – for guidance and help with common issues on page numbers see 
the insert page numbers advice from Microsoft. 

• Add a table of contents. 

A table of contents can be created to provide ease of navigation to your reader and to 
improve accessibility. 

To create a hyperlinked table of contents, on the home tab type table of contents into the 
lightbulb search box at the top of your document. You will then be given different options.  

As you add more headings, these will be added to your table of contents, as shown in this 
document, when you click on the content's header and update table. 

  

https://intranet.uwe.ac.uk/tasks-guides/Guide/creating-accessible-documents
http://go.uwe.ac.uk/ally
https://support.office.com/en-US/Article/Insert-page-numbers-9f366518-0500-4b45-903d-987d3827c007
https://support.office.com/en-us/article/insert-a-table-of-contents-882e8564-0edb-435e-84b5-1d8552ccf0c0
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Images 

When adding images ensure that the information is also provided in text. Also, all images 
should have alt text added. Alternative text is needed for screen readers to describe images. 
Ideally, all images should be described if they supply essential information. On the Home 
tab, type alt text into the light bulb search box to display the Alt Text pane. Click on the 
image and you can then enter basic details about the image. 

 

 

 

 

If the image is decorative, it can be marked as such by selecting the tick box and is applied 
to the image below. 

This Photo by Unknown Author is licensed under CC BY-SA 

https://support.microsoft.com/en-us/topic/add-alternative-text-to-a-shape-picture-chart-smartart-graphic-or-other-object-44989b2a-903c-4d9a-b742-6a75b451c669?ui=en-us&rs=en-us&ad=us
https://commons.wikimedia.org/wiki/File:Havana,_Cuba_(Unsplash).jpg
https://creativecommons.org/licenses/by-sa/3.0/
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Tables 

It is not easy to make tables accessible to screen reading software. Tables should not be 
used to manage the layout of a document as this often becomes confusing to those using 
screen readers. Tables should be reserved for tabular data. Where possible, you should 
provide a summary above or below the table of its contents. Tables should always have a 
header row, which explains the content of the columns. When adding a table remember 
to select repeat as header row at the top of each page, this ensures the table remains 
accessible if a user increased the font size or uses a screen reader. You may also find the 
guidance about creating accessible tables on the Gov.UK digital services webpage helpful. 

Using document styles 

If you are writing your thesis using Word, please use the styles toolbar to create structure in 
your document as this will make it easier for disabled users to adapt the document to meet 
their needs and to navigate around the document if using a screen reader.  

The use of styles and a hyperlinked table of contents also allows both examiners and 
general readers of theses to navigate around these long documents.  

 

When you have the Home tab at the top selected, highlight your text and use the Styles 
Pane on the right side of the tool bar to select the correct style, this will automatically set 
the colour, font, size, and line spacing for you. There is a quick video on how to use styles 
created by Microsoft that may help you if you are not familiar with using Styles. 

This Photo by Unknown Author is licensed under CC BY-NC-
ND 

https://support.office.com/en-us/article/Repeat-table-header-on-subsequent-pages-2ff677e0-3150-464a-a283-fa52794b4b41
https://www.gov.uk/guidance/content-design/tables
https://support.office.com/en-us/article/Video-Using-Styles-in-Word-9db4c0f4-2754-4294-9758-c14a0abd8cfa
https://kb.rspca.org.au/knowledge-base/how-should-i-care-for-my-pets-during-fireworks-displays/
https://creativecommons.org/licenses/by-nc-nd/3.0/
https://creativecommons.org/licenses/by-nc-nd/3.0/
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This UWE Bristol (University of the West of England) template has been built with 
embedded styles. This is a generic template useful for all types of documents. It is not 
mandatory to use this UWE Bristol template when writing up your thesis, but it does provide 
a good example of a document format utilising headings hierarchies to help navigation. 
UWE Bristol provides an online conversion tool to enable students and staff to make 
accessible copies of documents in a variety of formats. 

  

https://www.uwe.ac.uk/study/library/disabled-users/create-alternative-formats
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Example styles 

Heading 1 

Normal style: This text is set in 12pt Calibri Regular, left aligned.  

Heading 2 

Normal style: This text is set in 12pt Calibri Regular, left aligned.  

• Bullet list 

• Bullet list 

• Bullet list 

Heading 3 

Normal style: This text is set in 12pt Calibri Regular, left aligned. 

 

It is more accessible to use the emphasis style when trying to highlight a point rather than 
italics. 

This is Emphasis 

This is Intense Emphasis 

 

 

This is a Quote (use of Bold) 

This is an Intense quote 

For referencing, you should refer to your School’s preferred choice and the guidance 
provided by the library, for example, UWE Bristol Harvard but you can use a style choice for 
accessibility. 

 Subtle Reference 

Intense Reference 

Book Title 
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Adapting the template 

If you need to develop the UWE Bristol template further for your thesis, please 
remember to read the general requirements about preparing your thesis for submission 
which can be found online in the UWE Bristol Doctoral Academy handbook, follow basic 
rules below, and refer to the on writing accessible documents: UWE Bristol guidance 
pages on writing accessible documents: 

• Avoid the use of non - Serif fonts, such as Times New Roman. The more ornate the font, 
the fewer the number of individuals who will be able to read it. 

• 'Word Art' is not accessible. 
• Avoid the use of Italics and underlining wherever possible.  
• Use bold to emphasise items. 
• Continuous text should not be in capitals, although a couple of words in capitals is 

acceptable. 
• Align your text to the left. Do not use justified text as this makes the spaces between 

words uneven which can make it difficult for some individuals to read. 
• Double or 1.5 spacing between lines can make a document more accessible. 
• Margins should be 4.0 cm left and a minimum of 1.5cm right, and a minimum of 1.5cm 

top and bottom. This is so that your thesis can be printed, and spiral bound by the 
Doctoral Academy should your examiner exceptionally request a printed copy (rare 
occurrence). 

• At least one-line space should always be left between paragraphs. 
• Consider the contrast of your document. It is usually best to use dark ink against a pale 

background as this is best for users with specific learning difficulties such as dyslexia, 
although some users with visual impairments may find a pale font on a dark background 
easier. 

• Avoid using patterned backgrounds. 

Checking your document for accessibility 

You can quickly check your document using the accessibility checker in Word. Type 
accessibility checker into the lightbulb search box on the home tab and it will display 
suggestions for improvement. 

Accessible documents checklist – UWE Bristol library 

This checklist was created by the library and is a great resource to guide you when creating 
documents. 

 

 

https://docs.uwe.ac.uk/sites/library/_layouts/15/download.aspx?SourceUrl=https://docs.uwe.ac.uk/sites/library/Documents/Accessible%20document%20checklist.docx
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How do I move existing content into the new template? 

• Open the new Word template you wish to use. 
• Open your existing document and copy all the contents. You can do this quickly by 

pressing Ctrl and A, then copy. 
• Go to your blank template and right click. Select paste. You will be presented with some 

paste options, choose "merge formatting". 
• Review your document for any layout or design errors. Use the accessibility checker in 

Word to check for any issues. 
• Save your document. 

How to convert a word doc to PDF while keeping accessibility 
functionality 

When you submit your thesis to the UWE Bristol research repository for final assessment 
you must currently do this as a PDF document, but you don’t want to lose all the accessible 
functionality that you have built into your thesis format so follow the guidance relevant for 
your version of Microsoft Office as below.  

Windows 

Microsoft 365, Office 2021, Office 2019, Office 2016 

Select File > Save As or File > Save a Copy. 

Do one of the following: 

• To save the PDF to the same location as the original file, expand the file type 
dropdown list under the file name, select PDF (*.pdf), and then select More 
options.... The Save As dialog box opens. 

• To browse for a save location, select Browse. The Save As dialog box opens. Navigate 
to the location where you want to save the file, and then select PDF in the Save as 
type list. 

In the Save As dialog box, select Options. 

Select the Document structure tags for accessibility checkbox and the PDF/A compliant 
checkbox and then select OK. 

Microsoft 365 for Mac 

• Press Command + Shift + S and type the file name in the Name text box and select the 
Place. 

• In File Format, use the down arrow to browse through file types and select PDF. 

https://support.office.com/en-us/article/video-check-the-accessibility-of-your-document-9d660cba-1fcd-45ad-a9d1-c4f4b5eb5b7d?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/video-check-the-accessibility-of-your-document-9d660cba-1fcd-45ad-a9d1-c4f4b5eb5b7d?ui=en-US&rs=en-US&ad=US
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• Select Best for electronic distribution and accessibility (uses Microsoft online service). 
This ensures the PDF is tagged. 

• Select Export. 
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